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Preface

This document describes how to configure, use, and maintain the Cisco StadiumVision Mobile Reporter 
in Release 2.0 and later releases.

Document Revision History
Table 1 lists the technical changes made to this document since it was first published.

Table 1 Document Revision History

Date Change Summary

June 4, 2015 • Removed the Cisco Prime Infrastructure 1.2 or later requirement for 
area reporting in “Service Quality Reporting and Cisco Prime 
Infrastructure Integration”. Refer to “Configuring Cisco StadiumVision 
Mobile Reporter for Service Quality Reporting” for reporting 
information.

May 26, 2015 • Updated the version on the title page from 2.0 to 2.0.1-1.

• Updated the title page date from October, 2014 to May 26, 2015.

• Updated the Figure 1 on page 4. 

• Added a note about event scheduling restrictions in “Configuring the 
Cisco StadiumVision Mobile Reporter Server”.

April 13, 2015 Added a note to the “Information About Uploading Data” section on 
page 17 regarding the scheduling of events.

October 17, 2014 Initial version for Cisco StadiumVision Mobile Reporter Release 2.0.
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Document Organization
Document Organization

Related Documentation
For the listing page of all Cisco StadiumVision documentation, go to:

http://www.cisco.com/c/en/us/support/video/stadiumvision/tsd-products-support-series-home.html

• Cisco StadiumVision Mobile Release Notes

The following documents are available on Cisco.com at:

http://www.cisco.com/c/en/us/support/video/stadiumvision/products-maintenance-guides-list.html

• Cisco StadiumVision Mobile Reporter and Cisco StadiumVision Mobile Streamer Software 
Installation and Upgrade Guide—This guide contains instructions on how to install the 
StadiumVision Mobile Streamer software.

Module Description

Cisco StadiumVision Mobile Reporter 
Overview

Provides an introduction to the Cisco StadiumMobile 
Reporter network architecture and application.

Configuring the Cisco StadiumVision 
Mobile Reporter Server

Describes how to set up the Cisco StadiumVision Mobile 
Reporter system and is intended for the system installer 
and administrator (admin user).

Admin and Marketing User Report 
Reference

Provides a detailed reference of the reports available in 
Cisco StadiumVision Mobile reporter

System Accounts on the Cisco 
StadiumVision Mobile Reporter Server

Describes the default system accounts implemented by 
Cisco StadiumVision Mobile Reporter for access and 
control of certain server functions. 

Cisco StadiumVision Mobile Reporter Data 
Management

Describes the information that you should know about 
managing Cisco StadiumVision Mobile Reporter data 
and disk utilization on the server.

Cisco StadiumVision Mobile Reporter 
Failover

Decribes how to set up two servers for a redundant 
environment and how to manually fail over as needed.

Cisco StadiumVision Mobile Reporter Text 
Utility Interface

Provides an overview of the Cisco StadiumVision Mobile 
TUI and how to use it.

System State Reports Provides information about the System State Report 
feature that enables easy capture and export of system 
state data for Cisco StadiumVision servers, as well as raw 
data from the Cisco StadiumVision Reporter databases. 
This information can be sent to a remote support engineer 
to help troubleshoot any issues that occur with the 
system.

Troubleshooting the Raw Database Describes some of the ways that you can troubleshoot the 
Raw Data Database

Enabling a TAC User Account (Cisco 
Personnel Only)

Describes how to create a TAC account for Cisco 
Technical Support to have full access to the CLI.
iv
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Preface
Related Documentation
• Cisco StadiumVision Mobile Reporter Administration Guide—This guide describes how to install, 
configure and operate the StadiumVision Mobile Reporter server.

• Cisco StadiumVision Mobile Streamer Administration Guide—This guide describes how to install, 
configure and operate the StadiumVision Mobile Streamer server.

• Cisco StadiumVision Mobile SDK Guide—This guide describes how to use the library elements 
provided in the SDK (Software Development Kit) to create a venue application for mobile devices 
that accesses the Cisco StadiumVision Mobile feeds.

• Cisco UCS C220 Installation and Service Guide—This hardware guide contains information and 
instructions for installing and servicing the Cisco UCS C220 server. The UCS C220 is the server on 
which the StadiumVision Mobile Streamer and Reporter each run.

• Cisco UCS C200 Installation and Service Guide—This hardware guide contains information and 
instructions for installing and servicing the Cisco UCS C200 server. The UCS C200 is the server on 
which the StadiumVision Mobile Streamer and Reporter each run.

The following document is available by contacting your Cisco sales representative:

• Cisco StadiumVision Mobile Design and Implementation Guide—This guide provides additional 
information regarding the Streamer parameters described in this document. 

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional 
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and 
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as an RSS feed and set content to be 
delivered directly to your desktop using a reader application. The RSS feeds are a free service. Cisco 
currently supports RSS Version 2.0.
v
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Cisco StadiumVision Mobile Reporter Overview

First Published: October 17, 2014
Revised: June 4, 2015

This module includes the following topics:

• Cisco StadiumVision Mobile Reporter Architecture, page 3

• Service Quality Reporting and Cisco Prime Infrastructure Integration, page 4

• Cisco StadiumVision Mobile Reporter Application Overview, page 5

Cisco StadiumVision Mobile Reporter Architecture
Cisco StadiumVision Mobile Reporter works in combination with the Cisco StadiumVision Mobile 
Streamer, SDK, and client application to provide quality of experience statistics. It collects and 
processes data from the Cisco StadiumVision Mobile Streamer, SDK, and client application, and 
provides wireless network analysis through reports and live event charts. Figure 1 depicts the Cisco 
StadiumVision Mobile Reporter in the Cisco StadiumVision Mobile solution.

The Reporter accepts data from mobile devices in the stadium which are running an application based 
on the Cisco StadiumVision Mobile Client SDK. The clients report their data periodically and 
frequently, perhaps once per minute or more. The Cisco StadiumVision Mobile Reporter is designed to 
efficiently process large amounts of data and summarize it in multiple and flexible ways.
3
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Cisco StadiumVision Mobile Reporter Overview
Service Quality Reporting and Cisco Prime Infrastructure Integration
Figure 1 Cisco StadiumVision Mobile Architecture

Service Quality Reporting and Cisco Prime Infrastructure 
Integration

Beginning in Cisco StadiumVision Mobile Release 1.3, Cisco StadiumVision Mobile Reporter supports 
integration with Cisco Prime Infrastructure (PI), which is the management infrastructure used to 
configure a wireless network and access points (APs). Integration with Cisco PI was initially used both 
to discover AP names and areas as well as to provide data for WiFi client reporting.

Beginning in Release 2.0, the Reporter application supports a new mechanism to upload AP names using 
a CSV file. This is now the only recommended method of provisioning AP information for the Reporter 
application.

Integration with Cisco PI is now used only to track the total number of WiFi clients in the venue to 
provide data for the WiFi clients marketing report and for calculation of the Event Scorecard Uptake 
Score. Configuration of the PI is performed in the Text Utility Interface (TUI). For more details on 
configuring Cisco Prime Infrastructure. see the “Configuring Cisco Prime Infrastructure Integration for 
Cisco StadiumVision Mobile Reporter” section on page 13. For information about compatible PI 
versions, see the Cisco StadiumVision Mobile Release Notes.

The quality reporting feature has the following benefits:

• Every device with a Cisco StadiumVision Mobile application is also a telemetry point for Cisco 
StadiumVision Mobile metrics.

• Cisco StadiumVision Mobile Reporter collects, aggregates and reports by client, AP and AP area.

• AP groupings are created based on a common prefix in the AP names.
4
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Cisco StadiumVision Mobile Reporter Application Overview
Cisco StadiumVision Mobile Reporter Application Overview
This section provides an overview of the Cisco StadiumVision Mobile Reporter application and user 
roles. It includes the following sections:

• User Roles, page 5

• Admin User Interface, page 5

• Marketing User Interface, page 6

• Accessing the Cisco StadiumVision Mobile Reporter Application, page 6

User Roles
The Cisco StadiumVision Mobile Reporter supports the following two user roles for access to different 
areas of the application:

• admin—Intended for network engineers to get reports about venue network performance and also 
to access system management tools.

• marketing—Intended for user to obtain summary information about how the Cisco StadiumVision 
Mobile solution is being used at the venue.

Admin User Interface
The admin user can obtain certain reports from the Select View menu, and also perform administrative 
functions from the System Tools menu.

Select View Menu for the Admin User

The admin user has access to the following reports from the Select View menu:

• Event Scorecard—Contains a Quality and Uptake Score.

• Data Export—Additional reports made available using CSV file export. For more information, see 
the “Data Export Reports” section on page 25.

System Tools Menu for the Admin User

From the System Tools menu, the admin user can access the functions described in Table 1 to monitor 
and maintain the system.

Table 1 System Tools Menu Options

Report Name More Information

Upload Event Schedule “Uploading Event Schedule Information to Cisco StadiumVision 
Mobile Reporter” section on page 16

Upload Testpoints “Uploading Test Points to StadiumVision Mobile Reporter” section 
on page 18

Upload AP names “Uploading AP Information to StadiumVision Mobile Reporter” 
section on page 12
5
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Marketing User Interface
The marketing user role has access to the following reports for both live and historical data:

• Event Scorecard (historical view only)

• Peak Concurrent Video Viewers

• Unique Video Viewers

• Total Video Viewing Time

• SVM Client Demographic

• Concurrent SVM Clients

• Concurrent WiFi Clients

For more information, see the “Marketing User Reports” section on page 36,

Accessing the Cisco StadiumVision Mobile Reporter Application

Note Do not use a server URL that you might have bookmarked from prior releases that references port :8080, 
such as http://ip-address:8080. This will no longer work beginning in Release 2.0.

To access the Cisco StadiumVision Mobile Reporter application, complete the following steps:

Step 1 Using a supported browser version, open a browser window and type the URL for the Cisco 
StadiumVision Mobile Reporter server in the following sample format, where ip-address is the IPv4 
address of the server:

https://ip-address

or

http://ip-address

Note If you specify an HTTP address, the URL will automatically translate to a secure HTTPS URL. 

Disk Utilization “Monitoring Disk Utilization” section on page 54

Current Viewers “Current Viewers Report” section on page 24

Software Manager “Using the Software Manager to Upgrade Cisco StadiumVision 
Mobile Software” module of the Cisco StadiumVision Mobile 
Reporter and Cisco StadiumVision Mobile Streamer Installation and 
Upgrade Guide.

System State Report “System State Reports” module on page 79

Upload Data Archive “Performing a Restore of System Data” section on page 58

Download Data Archive “Viewing and Obtaining a Copy of Backup Data” section on page 55

Table 1 System Tools Menu Options (continued)

Report Name More Information
6
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Step 2 Log into Cisco StadiumVision Mobile Reporter with either the admin or marketing Username and 
corresponding account password. 

The graphical user interface is displayed for the type of account that you used to log in.

Note The first time that a user accesses Cisco StadiumVision Mobile Reporter, a message might appear that 
the server is not guaranteed secure due to the self-signed certificate on the server. If this occurs, 
acknowledge the security exception and proceed. 
7
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Configuring the Cisco StadiumVision Mobile 
Reporter Server

First Published: October 17, 2014
Revised: June 4, 2015

This module is intended for the system installer and administrator (admin user) to set up the Cisco 
StadiumVision Mobile Reporter system. It includes the following sections:

• Configuring Cisco StadiumVision Mobile Reporter for Service Quality Reporting, page 11 
(required)

• Uploading Event Schedule Information to Cisco StadiumVision Mobile Reporter, page 16 
(required)

• Uploading Test Points to StadiumVision Mobile Reporter, page 18 (optional)

• Configuring Performance Mode for StadiumVision Mobile Reporter, page 19 (as required)

For other server configuration information not documented in this module, see also the “Cisco 
StadiumVision Mobile Reporter Text Utility Interface” module.

Configuring Cisco StadiumVision Mobile Reporter for Service 
Quality Reporting

Note Beginning in Release 2.0, the Reporter application supports a new mechanism to upload AP names using 
a CSV file.

Although AP names and areas can still be discovered through integration with Cisco Prime Infrastructure 
in Release 2.0, the CSV upload method is preferred and recommended to provision this AP information.

Integration with Cisco PI is configured to allow the Reporter application to track the total number of 
WiFi clients in the venue to provide data for the WiFi clients marketing report and for calculation of the 
Event Scorecard Uptake Score.

• Uploading AP Information to StadiumVision Mobile Reporter, page 12 (preferred)

• Configuring Cisco Prime Infrastructure Integration for Cisco StadiumVision Mobile Reporter, 
page 13 (optional)
11
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Configuring Cisco StadiumVision Mobile Reporter for Service Quality Reporting
Uploading AP Information to StadiumVision Mobile Reporter
Complete this task to map each access point (AP) to an AP area so that you can obtain client reports in 
Cisco StadiumVision Mobile Reporter.

Prerequisites for Uploading AP Information

The admin user can download a template spreadsheet file to use as an example for specifying the AP 
information. See the “Information About Uploading Data” section on page 17.

Caution When adding new AP information, be sure to retain and include all AP information that is downloaded 
in the CSV file. New data is not merged with AP data from any prior upload—each time that you upload, 
the information contained in the CSV file replaces all existing information.

Be sure that you have the following information before uploading access point (AP) information to Cisco 
StadiumVision Mobile Reporter:

• Radio MAC address

• AP Name

• AP Area

Procedure

To create and upload AP information, complete the following steps:

Step 1 Log into the Cisco StadiumVision Mobile Reporter as admin.

Step 2 Click System Tools.

Step 3 Click Upload AP Names.

The “Upload Access Point (AP) names” screen is displayed.

Step 4 To access a sample template from which to specify your AP data, click Download a template.

a. Open or save the sample apnames.xlsx file.

b. Populate the spreadsheet with the appropriate AP data.

c. Save the spreadsheet as Unicode Text format, with a .txt file extension.

Step 5 From the “Upload Access Point (AP) names” screen, click Browse and navigate to the .txt file that you 
created in the previous step.

Step 6 Click Upload to load the AP names.
12
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Configuring Cisco Prime Infrastructure Integration for Cisco StadiumVision 
Mobile Reporter

In this method of obtaining AP information for service quality reporting, Cisco StadiumVision Mobile 
Reporter uses the Cisco Prime Infrastructure (PI) interface, and retrieves AP area information using rules 
from the data in PI.

This section includes the following topics:

• Prerequisites for Cisco PI Server Configuration, page 13

• Configuring Cisco PI Integration on Cisco StadiumVision Mobile Reporter, page 14

• Modifying the AP Name Field Prefix, page 15 (only when using PI for AP information)

• Enabling or Disabling Cisco PI Integration, page 16

Prerequisites for Cisco PI Server Configuration

Before you configure Cisco PI integration, be sure that you have met the following requirements:

• An SVM user account (name and password) is configured with access to the API on the PI server. 
See the “Cisco PI User Account Configuration Example” section on page 13.

• You have the following information:

– IP address of the PI server.

– The SVM user account (username and password) on the PI server.

– The list of network SSIDs to be used. 

• Verify that HTTPS is allowed for API calls if you have a firewall. The following API calls are made 
to PI using HTTPS:

– Access Point Summary

– Access Point Details

– Client Summary

Cisco PI User Account Configuration Example

In Cisco PI, an SVM user account needs to be configured with permissions to access the API on 
Prime Infrastructure. 

Figure 1 shows how to add an SVM user and define a custom User Defined Group. 
13
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Configuring Cisco StadiumVision Mobile Reporter for Service Quality Reporting
Figure 1 Adding a PI User

Figure 2 shows the User Defined Group permissions to configure for access to the Cisco StadiumVision 
Mobile Reporter API calls.

Figure 2 Prime Infrastructure Settings for Cisco StadiumVision Mobile Reporter API Calls

Configuring Cisco PI Integration on Cisco StadiumVision Mobile Reporter

To configure Cisco PI integration on Cisco StadiumVision Mobile Reporter, complete the following steps:

Step 1 Log into the TUI.

For more information, see the “Logging Into the TUI” section on page 73.

Step 2 From the Main Menu, go to System Settings > External Systems > Configure Prime Infrastructure 
(PI) system.
14
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Configuring the Cisco StadiumVision Mobile Reporter Server
Configuring Cisco StadiumVision Mobile Reporter for Service Quality Reporting
A series of configuration prompts appear to step you through entering the PI server integration 
information. 

Step 3 At the prompts, type the following information:

• IP address of the PI server.

• Username and password of the account configured on the PI server for SVM access.

• The network SSIDs to be used, separated by commas. If the SSID contains a space, surround it with 
double quotes as shown in the following example:

svmdata,sande-guest,"Stadium Center"

After you complete entering the PI server information, return to the External Systems menu.

Step 4 To verify the configuration, select View Prime Infrastructure (PI) Configuration.

Step 5 Confirm the PI configuration information that appears has been correctly specified.

Modifying the AP Name Field Prefix

Note This task is only used when obtaining AP information for Cisco StadiumVision Mobile Reporter from 
Cisco PI. It is no longer needed when using the recommended CSV file upload method to provision AP 
information.

This task allows you to group common characters found in AP names and group them for AP area 
reporting. AP names frequently are defined in parts that describe the locations of those APs in a venue. 
For example, “SJC1-LOWER-A100-3” might be an AP name for the third AP located in the 
“SJC1-LOWER-A100” section of the venue. In this task, you can define an Area for all AP names using 
these first three parts of the AP name: “SJC1-LOWER-A100.”

To modify the AP name prefix, complete the following steps:

Step 1 Log on with an snetac account to access the command line prompt.

Step 2 Change directory to /var/svm/config.

Step 3 Edit the variables.xml file.

At the bottom, you will find two lines. 

The first contains “AP_AREA_REGEX”. This line contains a regular expression to match the AP name. 
It contains regex 'grouping' operators which are parentheses. These parentheses mean 'take any 
characters inside the parentheses and assign it to a variable. The variable resulting starts with a $ and has 
a number, sequential based on reading the regex left to right.

The next line contains AP-AREA_REPLACEMENT. This uses those groupings found above.
15
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Uploading Event Schedule Information to Cisco StadiumVision Mobile Reporter
Enabling or Disabling Cisco PI Integration 

By default, the Cisco PI configuration is disabled on the Cisco StadiumVision Mobile Reporter server.

When Cisco PI integration is enabled, the Reporter application makes a call periodically (every 60 
seconds) to the PI server to collect statistics.

To enable or disable Cisco PI integration, complete the following steps:

Step 1 Log into the TUI.

For more information, see the “Logging Into the TUI” section on page 73.

Step 2 From the Main Menu, go to System Settings > External Systems and do one of the following:

• Choose Enable Prime Infrastructure (PI).

• Choose Disable Prime Infrastructure (PI).

The Cisco StadiumVision Mobile Reporter services are restarted and PI integration is either enabled or 
disabled.

Troubleshooting the Cisco PI Server Connection

To troubleshoot communication between Cisco StadiumVision Mobile Reporter and the Cisco PI server, complete 
the following steps:

Step 1 Log into the TUI.

For more information, see the “Logging Into the TUI” section on page 73.

Step 2 From the Main Menu, go to System Settings > External Systems > Test Prime Infrastructure (PI) 
Connection.

If you receive a JSON report after running the script, there the Cisco StadiumVision Mobile Reporter 
server has access to the Cisco PI server. If you receive an http or an error message, there is an issue.

Uploading Event Schedule Information to Cisco StadiumVision 
Mobile Reporter

The event schedule is used by the Cisco StadiumVision Mobile Reporter to know when event data is to 
be collected and processed into predefined reports and charts. The Event and Season reports depend on 
the event schedule to define a time period for each event and for the sports season.

This schedule is used to present the charts. When an event transpires, the Live Event reports will begin 
to show data from the start of the event. At some point in time after an event is over (the next night), the 
charts in categories for Event Report and Season Report will be updated with the latest summary data 
from the most recent event.
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Uploading Event Schedule Information to Cisco StadiumVision Mobile Reporter
To create an event schedule, use the included template that you can get using the System Tools > Upload 
Event Schedule menu option when logged in as admin.

Caution When you upload additional events, be sure to include existing events that you want to preserve. Start 
with the spreadsheet you used the previous time, and add the new events to that. Then upload the set of 
existing and new events using unique names for the new events.

Information About Uploading Data 
Note the following conditions about the event schedule and AP names:

• A spreadsheet application such as Microsoft Excel should be used to populate the spreadsheet.

• The spreadsheet should be saved as Unicode Text and a tab separated text file (a sample is shown in 
Figure 3).

The Upload Event Schedule dialog box contains a Download Template button and an Upload button 
to upload the populated spreadsheet. 

Figure 3 Event Schedule Spreadsheet Sample

Note Events can only be scheduled for single days (the Start Date and End Date must be the same day). Events 
cannot exceed 24-hours or be scheduled past midnight.

To create and upload an event schedule, complete the following steps:

Step 1 Log into the Cisco StadiumVision Mobile Reporter as admin.

Step 2 Click System Tools.

Step 3 Click Upload Event Schedule.

The “Upload an event schedule screen” is displayed showing the currently uploaded schedule.

Step 4 To access a sample template from which to specify your event data, click Download a template.

a. Open or save the sample EventSchedule.xlsx file.

b. Populate the spreadsheet with the appropriate event data.
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Troubleshooting Uploaded Data
Note You cannot change past events. For example, the current date is January 2 and in December 
you had uploaded an event for Jan 1 that went from 6-10pm, you cannot now re-upload that 
event and rename it nor change the times. You can only change names and times in the 
future. If you attempt to do this, the schedule will upload but no prior events will be changed.

c. Save the spreadsheet as Unicode Text format, with a .txt file extension.

Step 5 From the “Upload an event schedule” screen, click Browse and navigate to the .txt file that you created 
in the previous step.

Step 6 Click Upload to load the event schedule.

Step 7 When the upload is complete, verify the information shown on the screen to confirm success.

Troubleshooting Uploaded Data
If there are errors in the upload, an error form is displayed. The form indicates the line in the uploaded 
file that has the error, and a description of the problem. Examples of some errors are: 

• The event name is already used.

Caution Only an error message is given for duplicate event names in the same schedule. However, an error 
message is not given to block the upload of a secondary event schedule which has the same event names 
as the prior schedule. In this case, data is transferred from the previous schedule, and it is used to produce 
the charts for the events that are uploaded with same event names but at a later date.

• The end time is before the start time.

• The number of columns in the spreadsheet is not correct.

• The file is not in UTF format.

Uploading Test Points to StadiumVision Mobile Reporter
During deployment of Cisco StadiumVision Mobile at a venue, the deployment team can verify the WiFi 
performance throughout the venue using test points that are uploaded to Cisco StadiumVision Mobile 
Reporter and by running a special mobile application that reports on the manually-entered test point 
locations. 

It is not expected that performance is uniform throughout the venue, so multiple locations should be 
selected by the deployment team to test performance quality. This allows the report "D: Location 
Performance" to be generated by the admin user in Cisco StadiumVision Mobile Reporter. If adjustments 
are needed, they can be made and the location can be re-tested.
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Configuring Performance Mode for StadiumVision Mobile Reporter
Configuring Performance Mode for StadiumVision Mobile 
Reporter

Use Performance Mode when the expected number of clients is very large and not all functionality is 
required.

Note If the expected number of mobile clients is 5000 or greater, it is recommended that Performance mode 
be enabled.

Two things are affected when using Performance mode:

• The amount of logging is less verbose.

• The size of the memory heap is larger (20 GB) versus 15 GB in normal mode.

Enabling or Disabling Performance Mode

To enable or disable performance mode, complete the following steps:

Step 1 Log into the TUI.

For more information, see the “Logging Into the TUI” section on page 73.

Step 2 From the Main Menu, go to Services Control > Performance Mode and do one of the following:

• Choose Enable Performance Mode.

• Choose Disable Performance Mode.

The Cisco StadiumVision Mobile Reporter services are restarted and Performance Mode is either 
enabled or disabled.

Verifying Performance Mode Configuration
If you need to verify whether Performance Mode is enabled or disabled you can display the status using 
the TUI.

To verify performance mode configuration, complete the following steps:

Step 1 Log into the TUI.

For more information, see the “Logging Into the TUI” section on page 73.

Step 2 From the Main Menu, go to Services Control > Performance Mode > Display Performance Mode 
Status.

The display shows whether Performance Mode is enabled or disabled.

Step 3 Press any key to return to the Performance Mode menu.
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Configuring Performance Mode for StadiumVision Mobile Reporter
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Admin and Marketing User Report Reference

First Published: October 17, 2014

This module provides a detailed reference of the reports available in Cisco StadiumVision Mobile 
reporter. It includes the following sections:

• Admin User Reports, page 23

• Marketing User Reports, page 36

Admin User Reports
This section provides the details about the following types of reports for the admin user:

• Current Viewers Report, page 24 (System Tools menu)

• Event Scorecard—Quality and Uptake Scores, page 24 (Select View menu)

• Data Export Reports, page 25 (Select View menu)
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Admin User Reports
Current Viewers Report
The StadiumVision Mobile Reporter provides a report that depicts the current number of unique 
clients using StadiumVision Mobile, as shown in Figure 1.

Figure 1 Current Viewers Report

Event Scorecard—Quality and Uptake Scores
When you log into Cisco StadiumVision Mobile Reporter as an admin, the Event Scorecard report opens 
with the Season Summary as the default view.
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Figure 2 Event Scorecard Report—Default View

The uptake score is a measure of the number of WiFi devices that are on a venue’s WiFi network 
compared to how many of those devices are using the Cisco StadiumVision Mobile app. It is the 
percentage of devices using the SDK out of all the devices on the appropriate SSID in the wireless 
network.

Both the Quality Score and the Uptake Score will be a value between 0 and 100. When Prime 
Infrastructure is disabled, the Uptake Scores will be zero as shown in Figure 2.

Data Export Reports
The list of reports available for data export for the selected event are displayed from the Cisco 
StadiumVision Mobile Reporter admin screen using the Select View > Data Export option. 

Timesaver Depending on your data collection and the report that you are viewing, certain navigation buttons are 
available: 

—You can toggle between the Event Scorecard and Data Export report views for the selected event using 
the < and > buttons located in the middle of the report screen (on either side of the chart).

—You can select other events in the data collection using the < and > buttons located at the top of the 
report screen (on either side of the chart title).
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Figure 3 Data Export Reports—Download View

Table 1 lists the admin user reports available via the Data Export menu option, as well as a description 
of the report and its corresponding download filename. Reports are exported from the Cisco 
StadiumVision Mobile Reporter as CSV (comma-separated values) files contained within a .zip file. The 
CSV file can be viewed in a spreadsheet application.

Table 1 Admin User Data Export Reports

Chart Title Description

A: Venue Performance Timeline Errors per minute based on client SDK statistics.

B: AP Performance Quality fields organized by Access Point (AP).

C: Area Performance Key quality fields organized by logical area which can include multiple APs. 

E: Client Device Demographics Metrics categorized by Device Type. One row per client device type and band. Device 
Type is determined from the manufacturer and model information.

D: Location Performance Available for internal testpoint data only.

F: Client OS Demographics Metrics categorized by Device OS.

One row per client device type and band.

G: Client App Versions Metrics categorized by App Version. One row per client device type and band.

H: SDK Versions Metrics categorized by SDK Version. One row per client device type and band.

I: Unique Clients List of unique client devices. One row per client device type and band.

J: Client Sessions Detailed information about each client session. A client session occurs whenever a user 
on a mobile device starts an audio or video channel, or initiates a data file transfer from 
the Cisco StadiumVision Mobile Streamer. When that user activity stops, that client 
session is terminated, but the client can start a new session.

K: Streamer Input Quality Provides metrics indicating the quality of the Streamer input streams.
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Data Export—Report Field Descriptions
This section provides detailed descriptions of the fields contained within each report. 

Key Service Quality Fields
Table 2 lists the key fields for measuring Cisco StadiumVision Mobile service quality.

L: Concurrent SVM Clients Provides the data for the marketing chart named Concurrent SVM Clients. For more 
information on the marketing chart of the same name, see the “Concurrent SVM Clients” 
section on page 35.

M: Concurrent Video Viewers This report gives the number of unique users per channel per minute based on WiFi MAC 
address. It is updated every minute.

N: Reporter Server Statistics Provides system performance metrics and troubleshooting information.

Z: All Available Reports This is an archive that contains all reports in the above list, subject to there being data for 
that report for that time period.

Table 1 Admin User Data Export Reports

Chart Title Description

Table 2 Service Quality Field Descriptions

Field Name Description
Expected Value or Range for Normal 
Operation

Unrecoverable block error ratio Percentage of blocks that could not be 
recovered via forward error correction 
(FEC). An indicator of network 
multicast performance.

5% or less is an acceptable value. 
Greater than 5% indicated abnormal 
conditions.

(Video) Glitches per minute Number of buffering stalls per minute, 
accumulated over all of the devices 
reporting.

Greater than 6 indicates a problem.

Streamer announcements loss ratio (%) Percentage of the Cisco StadiumVision 
Mobile Streamer service 
announcements that were missed. An 
indicator of network multicast 
performance.

20% or less is an acceptable value. 
Anything greater than 20% indicates 
abnormal conditions.

Stats upload failure ratio Percentage of stat reports that could 
not be uploaded to Cisco 
StadiumVision Mobile Reporter. An 
indicator of network unicast 
performance.

10% or less is normal; 10-25% 
indicates an area for concern; greater 
than 25% indicates a very bad failure 
rate.

Average RSSI Received Signal Strength Indicator. A 
measurement of the power present in a 
received radio signal. 

5 GHz: -68 dbm or better
2.4 GHz: -63 dbm
Average: -65 dbm
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Venue Performance Timeline

Note This report is based only on video sessions, not on audio or data sessions.

AP Performance

Table 3 Venue Performance Timeline Report Fields Descriptions

Field Name Description

Time Time of measurement.

Block Error ratio (%) Blocks that could not be recovered via forward error correction (FEC).

Unrecoverable block error ratio (%) Percentage of blocks that could not be recovered via forward error correction 
(FEC). An indicator of network multicast performance.

Glitches Per Minute Number of buffering stalls per minute, accumulated over all of the devices 
reporting.

Table 4 AP Performance Report Field Descriptions

Field Name Description

AP Radio MAC Access point basic service set identifier. Use to identify access points and 
their associated clients.

Band WiFi spectrum assignment. 

AP Name Name assigned to the wireless access point.

AP Area Set of APs grouped as an area.

Date Event date.

Event Event name.

Non-Session Fields

Total unique SVM Clients Number of unique clients that Reporter has heard from, including clients that 
never consumed any video, audio or data sessions.

Reporting Activity (min) The total length of client reporting activity.

Stats Upload Failure ratio (%) Percentage of stat reports that could not be uploaded to Cisco StadiumVision 
Mobile Reporter. An indicator of network unicast performance.

Streamer announce loss ratio (%) Percentage of lost streamer announcements.

Average RSSI (dBm) Received Signal Strength Indicator. A measurement of the power present in 
a received radio signal. An average value.

Video Session Fields

Unique SVM Video clients Number of unique clients that consumed at least one video session.

Session time (min) Cumulative value of all the sessions from all the clients reporting, for the 
given AP and Band combination.

Unrecoverable block error ratio (%) Percentage of blocks that could not be recovered via forward error correction 
(FEC). An indicator of network multicast performance.
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Area Performance

Video glitches per minute Number of buffering stalls per minute, accumulated over all of the devices 
reporting for the given AP and Band.

Audio Session Fields

Unique SVM Audio clients Number of unique clients that consumed at least one audio session.

Session time (min) Cumulative value of all the sessions from all the clients reporting, for the 
given AP and Band combination.

Unrecover block error ratio (%) Percentage of blocks that could not be recovered via forward error correction 
(FEC). An indicator of network multicast performance.

Audio glitches per minute Number of buffering stalls per minute, accumulated over all of the devices 
reporting for the given AP and Band.

Data Session Fields

Unique SVM Data clients Number of unique clients that consumed at least one data session.

Session time (min) Session length of time in minutes.

Unrecover block error ratio (%) Percentage of blocks that could not be recovered via forward error correction 
(FEC). An indicator of network multicast performance.

Table 5 Area Performance Report Field Descriptions

Field Name Description

AP Area Set of APs grouped as an area.

Band WiFi spectrum assignment. 

Date Event date.

Event Event name.

Non-Session Fields

Total unique SVM Clients Number of unique clients that Reporter has heard from, including clients that 
never consumed any video, audio or data sessions.

Reporting Activity (min) The total length of client reporting activity.

Stats Upload Failure ratio (%) Percentage of stat reports that could not be uploaded to Cisco StadiumVision 
Mobile Reporter. An indicator of network unicast performance.

Streamer announce loss ratio (%) Percentage of lost streamer announcements.

Average RSSI (dBm) Received Signal Strength Indicator. A measurement of the power present in 
a received radio signal. An average value.

Video Session Fields

Unique SVM Video clients Number of unique clients that consumed at least one video session.

Session time (min) Length of session in minutes.

Unrecoverable block error ratio (%) Percentage of blocks that could not be recovered via forward error correction 
(FEC). An indicator of network multicast performance.

Table 4 AP Performance Report Field Descriptions (continued)

Field Name Description
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Client Device Demographics

Video glitches per minute Number of buffering stalls per minute, accumulated over all of the devices 
reporting for the given area.

Audio Session Fields

Unique SVM Audio clients Number of unique clients that consumed at least one audio session.

Session time (min) Length of session in minutes.

Unrecover block error ratio (%) Percentage of blocks that could not be recovered via forward error correction 
(FEC). An indicator of network multicast performance.

Audio glitches per minute Number of buffering stalls per minute, accumulated over all of the devices 
reporting for the given area.

Table 6 Client Device Demographics Report Field Descriptions

Field Name Description

Device Type Device name and model number.

Band WiFi spectrum assignment. 

Date Event date.

Event Event name.

Non-Session Fields

Total unique SVM Clients Number of unique clients that Reporter has heard from, including clients that 
never consumed any video, audio or data sessions.

Reporting Activity (min) The total length of client reporting activity for the specific device type and 
band.

Stats Upload Failure ratio (%) Percentage of stat reports that could not be uploaded to Cisco StadiumVision 
Mobile Reporter. An indicator of network unicast performance.

Streamer announce loss ratio (%) Percentage of lost streamer announcements.

Average RSSI (dBm) Received Signal Strength Indicator. A measurement of the power present in a 
received radio signal. An average value.

Video Session Fields

Unique SVM Video clients Number of unique clients that consumed at least one video session.

Session time (min) Length of session in minutes.

Unrecoverable block error ratio (%) Percentage of blocks that could not be recovered via forward error correction 
(FEC). An indicator of network multicast performance.

Video glitches per minute Number of buffering stalls per minute, accumulated over all of the devices 
reporting.

Audio Session Fields

Unique SVM Audio clients Number of unique clients that consumed at least one audio session.

Session time (min) Length of session in minutes.

Table 5 Area Performance Report Field Descriptions (continued)

Field Name Description
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Client OS Demographics

Unrecover block error ratio (%) Percentage of blocks that could not be recovered via forward error correction 
(FEC). An indicator of network multicast performance.

Audio glitches per minute Number of buffering stalls per minute, accumulated over all of the devices 
reporting.

Table 7 Client OS Demographics Report Field Descriptions

Field Name Description

Client OS Name of the operating system and version used on a client device.

Band WiFi spectrum assignment. 

Date Event date.

Event Event name.

Non-Session Fields

Total unique SVM Clients Number of unique clients that Reporter has heard from, aggregated for the 
specific Client OS, including clients that never consumed any video, audio or 
data sessions.

Reporting Activity (min) The total length of client reporting activity.

Stats Upload Failure ratio (%) Percentage of stat reports that could not be uploaded to Cisco StadiumVision 
Mobile Reporter. An indicator of network unicast performance.

Streamer announce loss ratio (%) Percentage of lost streamer announcements.

Average RSSI (dBm) Received Signal Strength Indicator. A measurement of the power present in a 
received radio signal. An average value.

Video Session Fields

Unique SVM Video clients Number of unique clients that consumed at least one video session.

Session time (min) Length of session in minutes.

Unrecoverable block error ratio (%) Percentage of blocks that could not be recovered via forward error correction 
(FEC). An indicator of network multicast performance.

Video glitches per minute Number of buffering stalls per minute, accumulated over all of the devices 
reporting.

Audio Session Fields

Unique SVM Audio clients Number of unique clients that consumed at least one audio session.

Session time (min) Length of session in minutes.

Unrecover block error ratio (%) Percentage of blocks that could not be recovered via forward error correction 
(FEC). An indicator of network multicast performance.

Audio glitches per minute Number of buffering stalls per minute, accumulated over all of the devices 
reporting.

Table 6 Client Device Demographics Report Field Descriptions (continued)

Field Name Description
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Client App Versions

Table 8 Client App Versions Report Field Descriptions

Field Name Description

Client App Version Client application version.

Band Ghz WiFi spectrum assignment. 

Date Event date.

Event Event name.

Non-Session Fields

Total unique SVM Clients Number of unique clients that Reporter has heard from, including clients that 
never consumed any video, audio or data sessions.

Reporting Activity (min) The total length of client reporting activity.

Stats Upload Failure ratio (%) Percentage of stat reports that could not be uploaded to Cisco StadiumVision 
Mobile Reporter. An indicator of network unicast performance.

Streamer announce loss ratio (%) Percentage of lost streamer announcements.

Average RSSI (dBm) Received Signal Strength Indicator. A measurement of the power present in a 
received radio signal. An average value.

Video Session Fields

Unique SVM Video clients Number of unique clients that consumed at least one video session.

Session time (min) Length of session in minutes.

Unrecoverable block error ratio (%) Percentage of blocks that could not be recovered via forward error correction 
(FEC). An indicator of network multicast performance.

Video glitches per minute Number of buffering stalls per minute, accumulated over all of the devices 
reporting.

Audio Session Fields

Unique SVM Audio clients Number of unique clients that consumed at least one audio session.

Session time (min) Length of session in minutes.

Unrecover block error ratio (%) Percentage of blocks that could not be recovered via forward error correction 
(FEC). An indicator of network multicast performance.

Audio glitches per minute Number of buffering stalls per minute, accumulated over all of the devices 
reporting.

Data Session Fields

Unique SVM Data clients Number of unique clients that consumed at least one data session.

Session time (min) Session length of time in minutes.
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SDK Versions

Table 9 SDK Versions Report Field Descriptions

Field Name Description

SDK Version Version number of the Cisco StadiumVision Mobile SDK.

Band WiFi spectrum assignment. 

Date Event date.

Non-Session Fields

Total unique SVM Clients Number of unique clients that Reporter has heard from, including clients that 
never consumed any video, audio or data sessions.

Reporting Activity (min) The total length of client reporting activity.

Stats Upload Failure ratio (%) Percentage of stat reports that could not be uploaded to Cisco StadiumVision 
Mobile Reporter. An indicator of network unicast performance.

Streamer announce loss ratio (%) Percentage of lost streamer announcements.

Average RSSI (dBm) Received Signal Strength Indicator. A measurement of the power present in 
a received radio signal. An average value.

Video Session Fields

Unique SVM Video clients Number of unique clients that consumed at least one video session.

Session time (min) Length of session in minutes.

Unrecoverable block error ratio (%) Percentage of blocks that could not be recovered via forward error correction 
(FEC). An indicator of network multicast performance.

Video glitches per minute Number of buffering stalls per minute, accumulated over all of the devices 
reporting.

Audio Session Fields

Unique SVM Audio clients Number of unique clients that consumed at least one audio session.

Session time (min) Length of session in minutes.

Unrecover block error ratio (%) Percentage of blocks that could not be recovered via forward error correction 
(FEC). An indicator of network multicast performance.

Audio glitches per minute Number of buffering stalls per minute, accumulated over all of the devices 
reporting.

Data Session Fields

Unique SVM Data clients Number of unique clients that consumed at least one data session.

Session time (min) Session length of time in minutes.
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Unique Clients

Client Sessions

Table 10 Unique Clients Report Field Descriptions

Field Name Description

Device UUID Universally unique identifier (UUID). For SVM, this ID is unique for each 
device for each installation of an SVM app.

MAC Address MAC address assigned to the SVM client (mobile device).

Manufacturer Manufacturer name.

Model Device model name.

OS Type Operating system type.

OS Version Operating system version.

Brand Device brand name.

HW Model Hardware model number.

Platform Platform name.

App Name Application name.

App ver Application version.

SDK ver Version of the Cisco StadiumVision Mobile Reporter client SDK.

Table 11 Client Sessions Report Field Descriptions

Field Name Description

Session UUID Session universally unique identifier (UUID). 

Session Type Either video, audio, or data.

Client device UUID Device universally unique identifier (UUID) .

BSSID Basic Service Set Identification (BSSID). The BSSID is the MAC address 
of the wireless access point.

Channel name WiFi channel.

Start Time 24H Time in 24 hour format.

Client MAC Address Client media access control address (MAC address).

Client IP Address Client IP address.

App name Application name.

App ver Application version.

SDK ver Version number of the Cisco StadiumVision Mobile SDK.

AP Access point MAC address.

AP Name Access point name.

Band GHz WiFi spectrum assignment. 

Wifi channel WiFi channel.
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Streamer Input Quality

Concurrent SVM Clients

Test point Internal field used by Cisco TAC.

Session time (min) Session time in minutes.

Blocks Received Total blocks received.

Unrecoverable block error ratio (%) Percentage of blocks that could not be recovered via forward error 
correction (FEC). An indicator of network multicast performance.

Video glitches per minute Calculated as the number of unrecoverable block errors per minute.

Audio glitches per minute Number of buffering stalls per minute, accumulated over all of the devices 
reporting.

Stats upload failure ratio (%) Percentage of stat reports that could not be uploaded to Cisco StadiumVision 
Mobile Reporter. An indicator of network unicast performance.

Streamer announce loss ratio (%) Percentage of lost streamer announcements.

Average RSSI (dBm) Received Signal Strength Indicator. A measurement of the power present in 
a received radio signal. An average value.

Table 12 Streamer Input Quality Report Field Descriptions

Field Name Description

Time Time in 24 hour format.

Channel Name Assigned channel name.

Total Delta A comparison of current and previous video protection windows.

Active Delta A comparison of current and previous active video windows.

Discontinuity Event An internal event in the Cisco StadiumVision Mobile Streamer which is used 
to rate video quality.

Table 13 Concurrent Clients Report Field Descriptions

Field Name Description

Time Time data was polled.

SVM Clients Number of Cisco StadiumVision Mobile clients.

Table 11 Client Sessions Report Field Descriptions (continued)

Field Name Description
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Concurrent Video Viewers

Reporter Server Statistics

Marketing User Reports
The marketing user has access to six report types. Each of these reports has two distinct presentation 
views. One view is the event view, which presents data collected during the span of one specific event. 
The other view is the season view, which presents summarized data for all of this seasons events that 
have been completed so far. 

Table 14 Concurrent Video Viewers Report Field Descriptions

Field Name Description

Time Time in 24 hour format.

Channel Name Assigned channel name.

Users Number of users.

Table 15 Reporter Server Statistics Report Field Descriptions

Field Name Description

Time Time in 24 hour format.

apache status One or zero; one means up, zero means down.

cassandra log msgs Configuration database log messages.

cassandra status One or zero; one means up, zero means down.

cpu util CPU utilization percentage.

disk free gb Hard disk free space in gigabytes.

disk used gb Hard disk space used in gigabytes.

disk util Hard disk utilization percentage.

httpd log msgs Apache httpd log messages.

load avg

memory util Memory utilization.

mongo log msgs Report database log messages.

mongo status One or zero; one means up, zero means down.

sym log msgs Cisco StadiumVision Mobile log messages.

svm server status One or zero; one means up, zero means down.

swap util Swap utility status.
36
Cisco StadiumVision Mobile Reporter Administration Guide

 



  

Admin and Marketing User Report Reference
Marketing User Reports
Reports are organized into three categories: Live Reports, Historical Reports, and the Season Reports 
(listed in Table 16).

• Live Reports—Real-Time reports

• Historical Reports—Reports for a specific event

• Season Reports—Cumulative reports over a span of time

The Cisco StadiumVision Mobile Reporter user interface distinguishes between the event view for past 
events and the event view for a live event happening right now. This separation is mostly a navigational 
one, as the live and historical event views are almost identical.

.
Table 16 Marketing User Reports

Report Type Report Description

Live Report

Current and Peak 
Concurrent Video Viewers 
Report

Displays both the current and peak number of 
StadiumVision Mobile video viewers.

Unique Video Viewers Displays the unique numbers of StadiumVision Mobile 
video viewers.

Total Video Viewing Time Displays the total time StadiumVision Mobile video has 
been viewed up to the current time.

SVM Client Demographic Displays the current number of StadiumVision Mobile 
clients by client operating system.

Concurrent SVM Clients Displays the concurrent number of StadiumVision 
Mobile clients.

Concurrent WiFi Clients Displays the number of WiFi clients connected during an 
event. 

Event Report

Season Report

Event Scorecard Report Quality and uptake scores.

Peak Concurrent Video 
Viewers Report

Displays the peak number of StadiumVision Mobile 
video viewers, by event or by season.

Unique Video Viewers Displays the unique numbers of StadiumVision Mobile 
video viewers, by event or by season.

Total Video Viewing Time Displays the total time StadiumVision Mobile video has 
been viewed for an event or a season.

SVM Client Demographic Displays the current number of StadiumVision Mobile 
clients by client operating system, for an event or a 
season.

Concurrent SVM Clients Displays the concurrent number of StadiumVision 
Mobile clients for an event or a season.

Concurrent WiFi Clients Displays the number of WiFi clients connected during an 
event. 
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Marketing Report Navigation and Showing Detail
• To see a report for a particular event, use the Select an Event dropdown (Figure 4).

Figure 4 Choosing an Event

• You can move between reports for the selected event using the < and > buttons located in the middle 
of the report screen (on either side of the chart).

• If you have multiple series of plots, you can show/hide plots on the chart using the button at the 
bottom of some reports.

• Several reports offer additional details for an event by clicking on the data point in the chart, and 
clicking show details, as shown in Figure 5.

Figure 5 Sample Report Time Point Detail
38
Cisco StadiumVision Mobile Reporter Administration Guide

 



  

Admin and Marketing User Report Reference
Marketing User Reports
Report Terminology
To maximize report comprehension, the following terminology should be understood.

.

Event Scorecard Report

Figure 6 Event Scorecard Report

Term Definition

WiFi Client A generic WiFi device, such as a tablet or smartphone, which may or may not 
be running an SVM client app.

SVM Client A Google Android or Apple iOS client with an SVM app installed.

Video Viewer An SVM client that is watching a video channel.

Concurrent Used to describe clients that are performing the same task at the same time. 
For example clients watching the same channel at the same time are 
concurrent viewers of that channel. 

Peak Concurrent Video 
Viewers

The event report shows the highest number of SVM clients that are viewed at 
the same time for each of the available video channels during a specific event. 
The live event report has a unique twist in that in addition to peak viewers it 
also shows the current number of viewers watching each channel right now.

The season report shows the highest number of SVM clients that concurrently 
viewed video for each of the past events, regardless of channel.
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Peak Concurrent Video Viewers Report

Figure 7 Peak Concurrent Video Viewers Report

Understanding Peak Viewer Reporting: Example

1. A group of 20 clients (A) watch the in-house channel for the entire game. 

2. A second group of 10 clients (B) watch the in-house channel for the first half. At half time they 
switch to ESPN. Finally, right before the start of the 2nd half all 10 clients are turned off.

3. A third group of 5 clients (C) show up during the second half, and watch ESPN for the remainder of 
the game. 

As a result the event report shows 30 peak viewers for the in-house channel, and 10 peak viewers for 
ESPN. The season report shows 30 peak viewers for the event.
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Figure 8 Unique Video Viewers Report

The event report shows the number of unique SVM clients that watched each of the available video 
channels during a specific event. An SVM client is uniquely identified by its UUID, and is only counted 
once per channel it viewed, even if it left a channel and resumed viewing it later. A client that watches 
multiple channels during the event is counted as one unique viewer for each of the channels it viewed.

The season report shows the total number of unique SVM clients that viewed video for each of the past 
events, regardless of channel watched. Hence each unique client is counted once per event only.

Example:
1. A group of 20 clients (A) watch the in-house channel for the entire game. 

2. A second group of 10 clients (B) watch the in-house channel for the first half. At half time they 
switch to ESPN. And right before the start of the 2nd half all 10 clients are turned off.

3. A third group of 5 clients (C) show up during the second half, and watch ESPN for the remainder of 
the game. 

As a result the event report shows 30 unique viewers for the in-house channel, and 15 unique viewers 
for ESPN. The season report shows 35 unique viewers for the event.
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Figure 9 Total Video Viewing Time

The event report shows the total duration that each channel was viewed during a specific event. This is 
calculated by summing up the number of minutes watched by each of the clients that tuned to this 
channel. It makes no difference if a client watched a channel once for 30 minutes or twice for 15 minutes. 

The season report shows the total number of minutes of video viewed across all channels, broken down 
by event. This aggregate number is a simple summation of the minutes recorded for each individual 
channel for that event.

Example:
1. A group of 20 clients (A) watch the in-house channel for 10 minutes each. 

2. A second group of 10 clients (B) watch the in-house channel for 20 minutes each. The same clients 
also watch ESPN for 10 minutes each.

As a result the event report shows the in-house channel being watched for 400 minutes, and the ESPN 
channel being watched for 100 minutes. The season report shows that a total of 500 minutes was watched 
during this event.
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Figure 10 SVM Client Demographic Report

The event report shows the total number of unique Google Android and Apple iOS clients that used the 
SVM client app at some point during the event. This includes devices that never tuned to a channel to 
watch video. The fact that the SVM client was launched, and briefly ran in the foreground, is sufficient 
for that client to be recorded. Hence the client demographic count is likely to be higher than that shown 
for the same event on the 'Unique Video Viewers' season. 

Example:
1. A group of 20 Apple iOS clients (A) watch the in-house channel during the first half.

2. A group of 15 Google Android clients (B) watch the in-house channel during the second half.

3. A group of 10 Apple iOS clients (C) use the SVM enabled app for in seat ordering only. They never 
tune to any of the video channels.

4. A group of 5 Google Android clients (D) use the SVM enabled app for way finding only. They never 
tune to any of the video channels.

As a result the event report shows 30 unique Apple iOS clients and 20 unique Google Android clients. 
The season report also shows 30 Apple iOS and 20 Google Android clients for this event.
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Figure 11 Concurrent SVM Clients Report

The event report shows the number of SVM clients that were active at the same time (concurrently) over 
the course of the event. This includes clients that are not tuned to a video channel. The fact that the SVM 
client is launched, and running in the foreground, is sufficient for that client to be recorded. Hence the 
concurrent SVM client count reported here is likely to be higher than that shown for the same event on 
the 'Peak Video Viewers' season report.

Example:
1. A group of 20 clients (A) were watching the in-house channel at 5:13 PM.

2. A group of 10 clients (B) were using the SVM enabled app for in seat ordering at 5:13 PM. Hence 
it is a given that they were not also watching video at that time.

3. The time of peak SVM activity is at 6:03 PM, when there are a total of 100 concurrently active SVM 
clients, including groups A and B.

As a result the event report shows 30 active clients at 5:13 PM. The season report captures the peak value 
of the event chart, which in this case is 100 concurrent clients.
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Figure 12 Concurrent WiFi Clients Report

Maintenance Window
Event and Season reports begin generation at 3:00 a.m. by default. If an event occurs at 10:00 p.m., the 
reports will be available after the 3:00 a.m. generation cycle.

Note The Cisco StadiumVision Mobile Reporter performs maintenance from 3:00 a.m. to 6:00 a.m. Do not 
schedule events to run during the maintenance window. 
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System Accounts on the Cisco StadiumVision 
Mobile Reporter Server

First Published: October 17, 2014

This module describes the default system accounts implemented by Cisco StadiumVision Mobile 
Reporter for access and control of certain server functions. 

The admin and marketing accounts are the basic user accounts that secure access to the Cisco 
StadiumVision Mobile Reporter feature configuration and operation. Other system accounts are reserved 
for special services or technical support and should not be modified unless you are instructed to do so, 
or you otherwise understand the impact to your server installation.

Information About System Accounts
Table 1 describes the system accounts in Cisco StadiumVision Mobile Reporter that are automatically 
implemented upon installation of the Cisco StadiumVision Mobile software.

Using the TUI, the installer should change the default passwords for these accounts after deployment of 
the server as needed for increased security. For more information, see the “How to Change System 
Account Passwords” section on page 50.

Table 1 Description of System Accounts

Account Purpose

Admin Account that provides access to the administrator functions in the Cisco 
StadiumVision Mobile Reporter user interface(UI). It is automatically implemented 
upon installation of the Cisco StadiumVision Director software. 

The username is: admin 

The default password is: cisco!123

Note Using the Text Utility Interface (TUI) to change the admin account password 
allows an installer to recover access to the UI.

Installer Account that provides access to the TUI using a directly-connected console or SSH 
client. 

The username is: installer 

The default password is: cisco!123
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How to Change System Account Passwords
You can change system account passwords from the defaults on the Cisco StadiumVision Mobile servers 
using the TUI. 

Tip To navigate through the TUI menus you must type the character that corresponds to the menu area where 
you want to go (a, b, c, and so on) and press Enter. 

To return to other menus, you must back out of the hierarchy of menus using one of the indicated keys 
to return you to prior menus.

To change system account passwords, complete the following steps:

Step 1 On the Cisco StadiumVision Mobile server, log into the TUI by doing the following:

a. Use a directly connected console, or use an SSH client from a laptop computer that is connected to 
the Cisco StadiumVision Mobile network to run a secure login to the Cisco StadiumVision Mobile 
server using the IP address for your server.

b. When the login prompt appears, enter the installer userid followed by the installer password at the 
password prompt.

Step 2 From the Main Menu, go to System Accounts.

Step 3 Select the system account whose password you want to change.

Step 4 At the prompt, type the new password.

Step 5 When prompted to confirm, retype the password.

Step 6 Press any key to return to the System Accounts menu.

Step 7 Return to the Main Menu and exit the TUI.

For more information about the TUI, see the “Cisco StadiumVision Mobile Reporter Text Utility 
Interface” module.

JMX Account that allows Java Management Extensions (JMX) clients to monitor and 
troubleshoot the Reporter.

The default password is: cisco!123

marketing User account that provides access to live and historical reports only.

The username is: marketing 

The default password is: cisco!123

TAC user Reserved for troubleshooting with remote shell access. This account should remain 
disabled and only activated when instructed by Cisco Technical Support for 
troubleshooting.

Table 1 Description of System Accounts

Account Purpose
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First Published: October 17, 2014

This module describes the information that you should know about managing Cisco StadiumVision 
Mobile Reporter data and disk utilization on the server.

This module contains the following topics:

• Information About Cisco StadiumVision Mobile Reporter System Data, page 53

• How to Manage System Data, page 54

Information About Cisco StadiumVision Mobile Reporter System 
Data

This section includes the following topics;

• Reporter Databases, page 53

• Other System Data, page 54

Reporter Databases
There are two databases in Cisco StadiumVision Mobile Reporter: 

• Raw data—Contains unprocessed event data.

• Chart and configuration data (reports)

The system automatically runs a daily backup of both databases at about 4:00 a.m. Both of these backup 
files are retained in the system for 20 days. You should get a copy of these files periodically and store 
them outside of the server to be sure that you can restore data from any unexpected failure.

The raw data can potentially use up all of the available system disk space, so the raw data is periodically 
purged from the system. The purge process removes all data from the raw database and stores it in an 
archive file. That archive file is retained for 20 days. By default, the system automatically removes all 
of the raw data in the reporter every 6 months—on June 1 and December 1—at 5:30 a.m. However, you 
can change this purge schedule using the Text Utility Interface (TUI).
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Other System Data
The Cisco StadiumVision Mobile Reporter server also stores other system data that can impact overall 
disk utilization, including System State Reports and ISO upgrade files. In addition to backup files, these 
files can be removed collectively from the system using the TUI Troubleshooting menu.

How to Manage System Data
This topic includes the following tasks:

• Monitoring Disk Utilization, page 54 (required)

• Performing a Restore of System Data, page 58 (required)

• Changing the Raw Data Purge Schedule, page 56 (as required)

• Deleting Files From the System, page 57 (as required)

• Performing a Restore of System Data, page 58 (as required)

Monitoring Disk Utilization
The Admin role can obtain a chart of the current disk utilization from the System Tools menu, as shown 
in Figure 1. 

Note If the disk utilization is too high, you can use the TUI to delete files by going to Troubleshooting > Disk 
Monitoring > Delete Files menu. For more information, see the “Deleting Files From the System” 
section on page 57.
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Figure 1 Disk Utilization Report

Viewing and Obtaining a Copy of Backup Data
The Cisco StadiumVision Mobile Reporter system automatically runs daily backups of the system 
databases and stores them for 20 days.

Note As a best practice, you should view the data archives and save a copy to an external storage device on a 
regular basis to maintain a copy of the files in the event that the reporter system becomes unusable or a 
hard drive failure occurs. If you want to support a redundant server environment and have the ability to 
failover to a backup server quickly and without any loss of data, it will be necessary to have these backup 
files available. For more information, see the “Cisco StadiumVision Mobile Reporter Failover” module.

To view and copy the data archive files, complete the following steps:

Step 1 Log into the Cisco StadiumVision Mobile Reporter server as admin.

Step 2 From the System Tools menu, select Download Data Archive.

Note After a fresh install, no backup files will exist. 

A list of files will appear, as shown below:

Tip Click the column heading to sort the reports.
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Figure 2 Cisco StadiumVision Mobile Reporter Download Data Archive File List

Note The CrossCheck report is intended for internal, non-production use only.

Step 3 Locate the following backup files:

Chart and Configuration data backup file:

• ChartAndConfigData.MMDDHHMI.tgz (where YYYYMMDDHHMI is the 
year/month/day/hour/minute)

Raw data backup files:

• MonitorEvent.YYYYMMDDHHMI.bson.gz 

• CepResults.YYYYMMDDHHMIbson.gz

• StreamerEvent.YYYYMMDDHHMI.bson.gz

• SvmMobileMapEvent.YYYYMMDDHHMI.bson.gz

• AllTogether.YYYYMMDDHHMI.zip'. This file contains all of the download-able reports after an 
event has finished. It is equivalent to selecting 'Z: All Available Reports' on the Admin page.

Step 4 Select and save the files onto a backup drive. 

Changing the Raw Data Purge Schedule
By default, the raw data database is cleared and stored in an archive file every 6 months at 5:30 a.m. You 
can change the data purge to occur once every 3 months, monthly, weekly, or daily. The archive file will 
be retained for 20 days.
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To change the purge schedule, complete the following steps:

Step 1 Log into the TUI.

For more information, see the “Logging Into the TUI” section on page 73.

Step 2 From the Main Menu, go to Server Administration > Change reporter data purge schedule menu.

Step 3 Type the number that corresponds to the purge scheduling period and press Enter, where:

• 1—Specifies that the raw database purge occurs daily.

• 2—Specifies that the raw database purge occurs weekly.

• 3—Specifies that the raw database purge occurs monthly.

• 4—Specifies that the raw database purge occurs every 3 months.

• 5—(Default) Specifies that the raw database purge occurs every 6 months (June 1 and December 1 
at 5:30 am

Step 4 Return to the Main Menu and exit the TUI.

Deleting Files From the System
If you need to free disk space on the Cisco StadiumVision Mobile Reporter, you can delete the following 
types of files:

• System State Reports

• Upgrade ISO files

• Backup/restore files

Tip If you want to retain any System State Reports or backup files, be sure to download and store them 
outside of the Cisco StadiumVision Mobile Reporter server before you delete.

To delete files from the system., complete the following steps:

Step 1 Log into the TUI.

Step 2 From the Main Menu, go to Troubleshooting > Disk Monitoring > Delete Files.

Step 3 Type the menu letter option that corresponds to the file type that you want to delete from the system and 
press Enter.

Step 4 At the prompt, type the letter to confirm the delete or cancel.

Step 5 Return to the Main Menu and exit the TUI.
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Performing a Restore of System Data
A restore is required for one of two reasons:

• Catastrophic failure—In this case, the Cisco StadiumVision Mobile Reporter is being rebuilt from 
scratch or being replaced with a spare server.

• Data loss or corruption—In this case, the Cisco StadiumVision Mobile Reporter needs to be rolled 
back to an earlier known good state. 

Prerequisites

Before you perform a restore from a catastrophic failure, be sure that the following conditions are met:

• The Cisco StadiumVision Mobile Reporter software is reinstalled. For more information, see the 
Cisco StadiumVision Mobile Reporter and Cisco StadiumVision Mobile Streamer Installation and 
Upgrade Guide.

• The DNS and NTP servers, and time zone are reconfigured (these settings are not included in the 
restore process).

• You have downloaded and have access to the most recent backup files external to the server. For 
more information, see the “Viewing and Obtaining a Copy of Backup Data” section on page 55.

Procedure

Note If you still have access to Cisco StadiumVision Mobile Reporter and are attempting to recover some data 
loss or possible corruption from a non-catastrophic system failure, then you can perform a restore from 
the most recent backup files that are already available on the system. You do not need to perform the 
steps associated with uploading a data archive, and can begin the following procedure from Step 5.

To perform a restore, complete the following steps:

Step 1 Log into Cisco StadiumVision Mobile Reporter as admin.

Step 2 Go to System Tools > Upload Data Archive.

Step 3 Click Browse to select a file to upload and select the backup that you want to restore.
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Figure 3 Cisco StadiumVision Mobile Reporter Restore File Dialog

Step 4 Click Upload to copy the file to the server.

Step 5 To restore the backup database file, log into the TUI and select Server Administration > Restore 
databases. 

Depending on the nature of the failure, restore either or both of the Chart and Config and Raw databases. 

Step 6 Once the script has completed verify that the restore was successful as follows:

a. Verify that the PI connection is operational. See the “External Systems” section on page 69 for more 
information.

b. Log in as admin user and verify that the expected event schedule appears, and that CSV files for all 
past events are present.

c. Log in as marketing user and verify that all historical events and season charts are present.
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The Cisco StadiumVision Mobile server environment does not currently support automatic failover to a 
backup server. If you want to build some redundancy into your environment, you can set up two servers 
that are configured identically to have the ability to manually fail over as needed.

This module includes the following topics:

• Setting Up Redundant Servers, page 61

• Performing a Manual Failover to a Secondary Server, page 62

Setting Up Redundant Servers
To set up redundant servers, complete the following steps:

Step 1 Install two Cisco StadiumVision Mobile Reporter servers. referred to as primary (active production 
server) and secondary (backup server).

Step 2 Assign each server a unique IP address.

Step 3 Configure each server identically, according to the options that you have set up in the Text Utility 
Interface (TUI), including but not limited to:

• DNS server

• NTP server

• Time zone

• Prime Infrastructure (PI) integration

Performing a Manual Failover to a Secondary Server

Caution If the primary Cisco StadiumVision Mobile Reporter server that is used in production becomes unusable 
or unable to be accessed, it is important that you have already externally retained backup copies of your 
production server system data, For more information, see the “Viewing and Obtaining a Copy of Backup 
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Data” section on page 55.

To perform a manual failover to a secondary server, complete the following steps:

Step 1 Download the following files from the primary Cisco StadiumVision Mobile Reporter to your laptop, 
and select the most recent version for each file, where the asterisk (*) in the filename shown here 
represents a timestamp in the actual file name:

• ChartAndConfigData.*.tgz 

• CepResults.*.bson.gz

Step 2 Restore these files onto the secondary server.

For more information, see the “Performing a Restore of System Data” section on page 58.

Step 3 Log into the Cisco StadiumVision Mobile Streamer.

Step 4 On the Defaults tab, change the Reporter URL to reflect the address of the secondary Cisco 
StadiumVision Mobile Reporter server.
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First Published: October 17, 2014

The Cisco StadiumVision Mobile Reporter Text Utility Interface (TUI) provides a console-based text 
interface for use by system installers and on-site troubleshooting personnel. The TUI can be used to 
perform routine system tasks such as modifying system configurations, changing passwords, and 
checking system logs. Remote TAC access and troubleshooting can both be facilitated from the TUI in 
the event of a StadiumVision Mobile Reporter outage or failure.

This module includes the following topics:

• Information About the TUI, page 65

• How to Access the TUI, page 73

Information About the TUI
This section includes the following topics:

• Overview of the TUI Menus, page 66

• Working with the TUI Interface, page 72
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Overview of the TUI Menus
The TUI is a nested structure of menus with options that allow you to drill down to specific system tasks 
to be performed on the server. The primary menus are:

• Main Menu

• System Settings

• System Accounts

• Services Control

• Server Administration

• Troubleshooting

Table 1 provides a description of the primary menus included in the Cisco StadiumVision Director TUI.

Figure 3 shows an overall view of the Cisco StadiumVision Mobile Reporter TUI.

Table 1 Description of the Primary TUI Menus

Menu Name Use this menu to. . .

Main Menu Access all other menus or exit the TUI.

System Settings Change server network configuration, generate a certificate, configure 
system date/time, display system information, and configure external 
systems.

System Accounts Change default system passwords. 

For more information about system accounts and modifying them, see the 
“System Accounts on the Cisco StadiumVision Mobile Reporter Server” 
module.

Services Control Access services running on the server to start, stop, or show status.

Server Administration Manage the operation and software configuration of the server.

Troubleshooting Run a ping command, monitor disk space usage, clean up files to free up 
disk space, or display system logging information.
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Figure 1 TUI Map for Cisco StadiumVision Mobile Reporter
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The following sections provide a brief description of each TUI menu item.

• System Settings, page 68

• System Accounts, page 69

• Services Control, page 69

• Server Administration, page 70

• Troubleshooting, page 70

System Settings

Network Settings

Setup Network Information

Allows for configuration of network devices and the DNS server.

Manually edit network config file

• Edit eth0 config file - allows for configuration of Ethernet port 0

• Edit eth1 config file - allows for configuration of Ethernet port 1

Edit hosts file

Opens the vi editor to modify the /etc/hosts file.

Generate certificate file

Generates a new self-signed certificate for network access using HTTPS.

Note If you want to use a signed certificate that you have purchased, contact Cisco Technical Support to install 
it.

Data and Time Settings

The system date, timezone, and NTP server address should be set during the installation process. If these 
items were not configured during installation, it is critical to configure these items to avoid time drift 
and to ensure accurate reporting.

Set system date

Allows you to manually set the date.

Change timezone

Allows for setting the timezone. Choose a number next to the correct timezone.

Set NTP server address

Allows for setting the Network Time Protocol (NTP). Enter an IP address for a valid NTP server.

Modify NTP configuration file

Allows for manually editing the NTP configuration file.
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System Information

Displays network information for eth0 and eth1 ports, hosts file, DNS information, and NTP server 
information.

External Systems

Allows you to configure, enable, and test integration with a Prime Infrastructure (PI) server for service 
quality reporting. For more information, see the “Configuring Cisco Prime Infrastructure Integration for 
Cisco StadiumVision Mobile Reporter” section on page 13.

System Accounts
The System Accounts menu allows you to manage accounts on the Cisco StadiumVision Mobile 
Reporter server. For more information about changing system accounts, see the “System Accounts on 
the Cisco StadiumVision Mobile Reporter Server” module.

You also can enable and disable a TAC user for a Cisco TAC representative to remotely troubleshoot the 
Cisco StadiumVision Mobile Reporter server. This allows remote shell access to be used for remote 
troubleshooting purposes. Always disable this access once you complete troubleshooting the system. For 
more information, see the “Enabling a TAC User Account (Cisco Personnel Only)” module.

Services Control

Chart and Config Database

Shows information about the service that controls the Charts and Configuration database, and allows you 
to start or stop that database service.

Networking

Shows information about the eth0 and eth1 ports and allows you to restart the networking service.

Raw Data Database

Shows information about the service that controls the Raw Data database, and allows you to start or stop 
that database service.

StadiumVision Mobile Reporter Services

Displays information about the svmreporter service, and allows you to start or stop it.

Web Server

Displays information about the httpd service, and allows you to start or stop it.

Performance Mode

Displays whether or not Performance Mode is enabled, and allows you to enable or disable it.
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Server Administration

Display Software Version

Displays the installed software version.

Setup automatic data archive

Note This TUI option is not supported for Cisco StadiumVision Mobile Reporter.

On a nightly basis, backups are automatically run for Chart and Config and Raw Data databases. These 
file archives are available to download. The file archives are automatically removed from the Cisco 
StadiumVision Mobile Reporter after 20 days. For more information, see the “Cisco StadiumVision 
Mobile Reporter Data Management” module.

Restore databases

See the “Performing a Restore of System Data” section on page 58.

Repair databases (re-index data)

• Repair Raw Data database

See the “Repairing the Raw Data Database” section on page 86.

Rebuild databases (lose data)

• Rebuild Raw Data database (data will be lost)

• Rebuild Chart and Config database (data will be lost)

• Re-seed Chart and Config database

See the “Rebuilding the Raw Data Database” section on page 86.

Reboot

Reboots the Cisco StadiumVision Mobile Reporter.

Power Off

Powers the Cisco StadiumVision Mobile Reporter off.

Troubleshooting

Ping a host

Allows for connectivity testing by pinging an IP address.

View logs

Log files are written as events transpire. The log files are available to be downloaded via HTTP. The log 
files are intended for a Cisco TAC representative to aid in troubleshooting. The log files are rotated out 
of the system, typically after 20 days.

• System logs

– System console messages (/var/log/messages)

– Authentication/Authorization logs (/var/log/secure)
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– Driver messages (dmesg)

• Tail log

• View log

• Web Server logs (httpd)

– Web Server access log (/var/log/httpd/error_log)

• Tail log 

• View log

– Web Server error log

• Tail log 

• View log

• Charts database logs

– Chart and Config data database log

• Tail log 

• View log

– Chart and Config data database stdout file

• Tail log 

• View log

• Raw data database log

– Raw database log for today

• Tail log

• View log

• StadiumVision Mobile Reporter Log

– catalina.out

• Tail log

• View log

– catalina.2012-12-11.log

• Tail log

• View log

• localhost.log

• Tail log

• View log

• localhost_access_log.date.txt

• Tail log

• View log

– svmreporter.log

• Tail log

• View log
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Working with the TUI Interface
This section includes the following topics:

• Menu Navigation, page 72

• File Editor, page 72

Menu Navigation

The Main Menu is displayed when you log in. To navigate through the menus you must type the character 
that corresponds to the menu area where you want to go (a, b, c, and so on) and press Enter. 

To return to other menus, you must back out of the hierarchy of menus using one of the indicated keys 
to return you to prior menus. 

Caution Avoid pressing Ctrl-c from the TUI. This immediately terminates the TUI session and if services were 
started during the session they might stop running. Use the TUI menu system to exit the interface.

File Editor

Several of the TUI options open server system files for you to modify using the Unix system vi editor. 
The following configuration files are editable from the TUI:

• DNS information—/etc/resolv.conf

• NTP server information—/etc/ntp.conf

• Server host information—/etc/hosts

• Network configuration—/etc/sysconfig/network-scripts/ifcfg-eth0

Before modifying configuration files, you should be familiar with the simple editing techniques used 
within the vi editor. Table 2 describes some of the more common vi Editor commands.

Table 2 Common vi Editor Commands

Command Description

ZZ or :wq Exit vi and save changes.

:q! Exit vi without saving changes.

Esc key Exit current mode and enter vi command mode.

Cursor Movement

h Move left (backspace).

j Move down.

k Move up.

l Move right.

Enter key Move to the beginning of the next line.

Inserting

a Append character after cursor.

i Insert character before cursor. Enters INSERT mode.
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How to Access the TUI
This section includes the following topics:

• Logging Into the TUI, page 73

• Exiting the TUI, page 74

Logging Into the TUI
To access the TUI, you need either physical console access or an SSH client such as PuTTY. 

To log into the TUI, complete the following steps:

Step 1 Do one of the following:

• Access the server using a directly-attached console.

• In the SSH client software, specify the IP address of the server that you want to access.

Step 2 When the “login as:” prompt appears, type installer and press Enter (Figure 2):

Figure 2 TUI Login Prompt

Step 3 At the password prompt, type the installer password and press Enter.

Note In the terminal emulator, the keystrokes for your password entry are not shown.

r Replace character under cursor with next character typed.

R Keep replacing character until [Esc] is pressed.

Deleting

db Delete word before cursor.

dd Delete line under cursor.

dw Delete word under cursor.

x Delete character under cursor.

P Undo deletion of characters, words, or lines before cursor.

p Undo deletion of characters, words, or lines after cursor.

Table 2 Common vi Editor Commands (continued)

Command Description
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When the login is successful, the Main Menu is displayed along with some basic system information at 
the top of the screen (Figure 3).

Figure 3 Cisco StadiumVision Mobile Reporter TUI Main Menu

Exiting the TUI

Caution Avoid pressing Ctrl-c from the TUI. This immediately terminates the TUI session and if services were 
started during the session they might stop running. Use the TUI menu system to exit the interface.

To exit the TUI, complete the following steps:

Step 1 Go to the TUI Main Menu.

Tip If you are in a TUI submenu, you will have to type R or < or , and press Enter to navigate back 
to the Main Menu.

Step 2 Type X and press Enter.
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System State Reports

First Published: October 17, 2014

The System State Report feature enables easy capture and export of system state data for the Cisco 
StadiumVision Mobile Reporter server. This information can be sent to a remote support engineer to help 
troubleshoot any issues that may occur with the system.

This module includes the following topics:

• Information About System State Reports, page 79

• How to Run a System State Report, page 81

Information About System State Reports
Figure 1 shows the System State Report screen.

Figure 1 System State Report Screen
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Information About System State Reports
Table 1describes the options provided on the System State Report screen.

Table 1 System State Report Screen Description

Category Description

Report Destination Allows you to choose whether you want to download the 
report or view it in your browser window. If you check 
Download report, your browser will download the resulting 
report when the system state report is ready. You can save this 
file on your computer, view its contents, and mail it to support 
personnel. 

If you check View in browser, the resulting report is available 
for immediate viewing online via the link provided.

Level Selects the level of detail you want in the report.

• Basic First Level: Provides detailed information of the 
system state, including information on configuration and 
current performance of the hardware, the operating 
system, the database, the Java VM, and the SV 
application.

• Java Heap Dump: Displays a report indicating the 
internal activities of the selected Java Virtual Machine 
(JVM). Before running the report, you will see a selection 
screen showing  the process ID, the name of the JVM, and 
its command line. Select one of the JVMs that you wish to 
get the head dump for, then click Get Heap Dump. The 
heap dump report will generate.

Exercise care in taking a heap dump, because while this is 
running, it can affect system performance.

• Full SVM Logs: Displays a list of system log files 
available for retrieving from the server and copying to 
your local drive or sending to Cisco Support. If you select 
View in  Browser, then you can view the logs online as 
well.

• Export Raw Data: Provides a mechanism to export the 
raw data from the Cisco StadiumVision Mobile Reporter.

Previous Reports Lists up to 15 of the most recent exports of the system state 
reports that were collected. The reports may have been 
collected from someone accessing this request page, or from a 
system scheduled task. 

You can select one of the links to download to your local drive 
to view or email to Cisco support.
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How to Run a System State Report
This section includes the following tasks:

• Running a System State Report, page 81

• Viewing the Contents of the Zip File, page 82

• Exporting Raw Data From Cisco StadiumVision Mobile Reporter, page 82

Running a System State Report
You can run a System State Report when logged into Cisco StadiumVision Mobile Reporter, or from a 
browser when the reporter GUI is not available.

Using the Cisco StadiumVision Mobile Reporter GUI to Run a System State Report

To use the GUI to run a System State Report, complete the following steps:

Step 1 Log into Cisco StadiumVision Mobile Reporter as admin.

Step 2 From the System Tools menu, click System State Report.

Step 3 Under Report Destination, select one or both types, Download report and/or View in browser.

Step 4 Under Level, select the type of report that you want to run.

Step 5 Click Get System State.

A status bar is displayed while the report is generating.

Running a System State Report When the Cisco StadiumVision Mobile Reporter GUI is Not Available

To run a System State Report when the GUI is not available, complete the following steps:

Step 1 Log into the TUI as installer.

Step 2 From the TUI, shut down the reporter by going to Services Control > StadiumVision Mobile Reporter 
Services.

Step 3 Click Stop Service.

Step 4 Exit the TUI.

Step 5 From your browser, navigate to the system state report directly with the following URL, where 
reporter-ip-address is replaced with the IP address of your server:

https://reporter-ip-address/cgi-bin/snap.cgi
81
Cisco StadiumVision Mobile Reporter Administration Guide

 



  

System State Reports
How to Run a System State Report
Viewing the Contents of the Zip File
After the extract report runs, a resulting page will display Report is ready. If you selected View in 
browser, a link will appear to view the report in the browser. Depending on your browser and its settings, 
if you selected Download Report, you may get a dialog box to save the report on your local machine. 
If so, save it as desired. 

If the automatic download does not work, you can click on the link after the word Download to again 
download the file. This is a compressed file containing multiple parts to the report. The file has the 
extension .zip, indicating a compressed folder. The heap dump is a compressed report file which you can 
save to your local drive and forward to support personnel for troubleshooting, packaged just the same 
way that the Basic Level report is. 

Once you have downloaded the report file to your PC, you will have a .zip file. You can email it to Cisco 
support as is. 

Note The format of the file name is the date and time that the report was run.

To view the contents of this file, complete the following steps:

Step 1 Double-click on the file to open the .zip file archive manager. 

The contents of this file depends on the file compression software program installed on your PC. For 
example purposes, these instructions will assume you have WinZip on a PC. 

Step 2 Click Extract and extract ALL the contents of the archive to a new directory on your local drive. 

Step 3 Using Windows Explorer, navigate to the extracted directory you just created. In the resulting folder is 
a file named index.html. Double-click that file and it will open in your internet browser.

Step 4 You can now review the rest of the report by clicking on links available from this page.

Step 5 In the case of the heap dump and log file reports, there is no index.html. Simply navigate down the levels 
of folders until you see the log files of interest.

Exporting Raw Data From Cisco StadiumVision Mobile Reporter

To export raw data, complete the following steps:

Step 1 From the System State Report screen, select Export Raw Data.

Step 2 Click Get System State.

Step 3 In the Start Date and End Date fields on the Raw Data Export screen, type the date and time range for 
the period from which you want data, as shown in Figure 2.

The default value is based on the last event times in the event schedule.
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Figure 2 Cisco StadiumVision Mobile Reporter Raw Data Export Dialog

Step 4 Under Collections, select one or more of the checkboxes to specify where you want to get the data from:

• Client—Data from mobile clients using the Cisco StadiumVision Mobile SDK. 

• PI—Data from Cisco Prime Infrastructure (if using the Cisco StadiumVision Mobile-PI integration 
capability).

• Streamer—Data sent from the Cisco StadiumVision Mobile Streamer to the Cisco StadiumVision 
Mobile Reporter.

Step 5 (Client data only) Under Clients sub-criteria, specify additional options to further refine the data that 
is returned.

You can select either a specific client MAC address, or a device UUID or a session UUID. This data 
might be known to you from studying the report ‘J: Client Sessions’. You can only specify one type of 
sub-criteria, and only one specific mac address or UUID.

Note For PI and Streamer data collections, All in time range is automatically selected and is all that 
applies.

Step 6 Click Get raw data. 

The report generates as a .csv file inside of a .zip archive file.
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Sometimes, such as in the event of a sudden power loss, the raw data database might not restart properly. 
This module describes some of the ways that you can troubleshoot the Raw Data Database. If a rebuild 
of the database is required, you will need to contact Cisco Technical Support.

This module includes the following topics:

• Displaying the Status of the Raw Data Database, page 85

• Raw Data Database is Not Running, page 85

Displaying the Status of the Raw Data Database
To display the status of the raw database, complete the following steps:

Step 1 Log into the TUI.

For more information, see the “Logging Into the TUI” section on page 73.

Step 2 From the main menu, go to Services Control > Raw Data Database > Show Status.

Step 3 If the database is not running, try to start it. See the “Starting the Raw Data Database” section on 
page 86.

Raw Data Database is Not Running
If the Raw Data Database service status shows that it is not running, perform the following tasks to 
recover:
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Starting the Raw Data Database

If the raw database is not running, complete the following steps:

Step 1 Log into the TUI.

For more information, see the “Logging Into the TUI” section on page 73.

Step 2 From the main menu, go to Services Control > Raw Data Database > Start Service.

Step 3 After the Start Service process completes, run the Show Status command.

If the database is not running after you started it, try to repair the database. See the “Repairing the Raw 
Data Database” section on page 86.

Repairing the Raw Data Database
If the Raw Data Database is not running after you attempt to start it, then try to run a repair of the 
database. The repair process re-indexes the data.

To repair the Raw Data Database, complete the following steps:

Step 1 Log into the TUI.

For more information, see the “Logging Into the TUI” section on page 73.

Step 2 From the main menu, go to Server Administration > Repair Database (re-index data).

The system automatically starts the database after the repair is complete.

Rebuilding the Raw Data Database

Caution This process will result in a loss of data. Be sure to contact Cisco Technical Support and perform this 
task as a last resort.

To rebuild the Raw Data Database, complete the following steps:

Step 1 Log into the TUI.

For more information, see the “Logging Into the TUI” section on page 73.

Step 2 From the main menu, go to Server Administration > Rebuild databases (lose data).

The system automatically starts the database after the rebuild is complete.
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For troubleshooting, Cisco technical support personnel will need to create a Technical Assistance Center 
(TAC) account to have full access to the CLI. 

To enable a TAC user account, complete the following steps:

Step 1 From the TUI main menu, go to System accounts > Enable/Disable TAC user > Enable TAC user 
account.

Confirmation that the TAC account has been enabled appears on the screen.

Step 2 Access the SNE TAC Token Exchange at http://10.194.171.10/cgi-bin/SNETACAuth.cgi.

Step 3 Generate an authentication key by entering the IP address of Cisco StadiumVision Mobile server and 
click Submit. 

A sample screen is shown in Figure 1.

Figure 1 SNE TAC Token Exchange
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Step 4 Copy the generated token (save it someplace as you will need it later).

Step 5 Use SSH (VPN in first if needed) to log into the Cisco StadiumVision Mobile server for which you are 
requesting access using the username "snetac" and the default password.

Step 6 Paste the copied token into the SSH session when prompted for a token.

Step 7 Go through the password setting process when prompted.

An SSH account is now set up with the username that you specified, and the password you previously 
entered into this system. This account will be active for the next 24 hours. You may extend and/or 
re-enable your account at any time by going through this process again.
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